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Safety Notice: 
 

Please ensure that you read and understand all of the safety rules that comes with your tools.  If used 

properly, they will provide you with a fun, successful experience creating this sensor.  If used 

improperly, many of the tools can cut or burn, providing a health risk, and ruining the fabrication 

experience. 

 

Included at the end of this manual are documents pertaining to all of the parts included in this kit.  

Please look through these for the manufacturers recommended safe handling instructions.  Some parts 

are small and present a choking hazard; others are sharp and have the ability to penetrate skin.  Some 

components require safe handling to prevent accidental shock to the component, or safe heating to 

prevent the melting of parts. 

 

Be safe, Have fun. 

MIT Sea Grant 
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Introduction 
 

The MIT Sea Perch Sensor Suite is an electronics project designed to educate the fabricator in the 

electronics and mechanics of ocean sensing technology.  Through building this project, knowledge will 

be gained in basic and intermediate electronics, microcontroller programming, and waterproof design.  

It is possible to exclusively build this project without taking the time to learn the fundamental principles 

at work; and doing so will result in a working sensor.  However if the time is taken, a world of sensors, 

autonomy, and ocean understanding can be unlocked. 

The final product that will be assembled by following these instructions is a simple water quality sensor.  

It is capable of sensing depth, conductivity, temperature, and light, and storing the data for hours at a 

time on a MicroSD card. 

Some modifications have been made to circuit 2.4, creating circuit 2.4.1.  Essentially, the circuit is the 

same allowing for the same manual to be used for both models.  You may note slight variations in 

imagery in this document when compared to your circuit.  Where it is important, a note will exist 

indicating the difference and how it applies to your board. 
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Section 1 – Circuit Board Assembly 
 

Please read all steps carefully.  The text will be kept to a minimum, but it is essential to make note of it 

where it exists. 

 After verifying that all parts are included and the safety notices have been read, begin by 

creating a clean workspace.  There are many small parts that will easily be lost. 

 The majority of the steps for this section are presented in photo format.  Compare your circuit 

board to the photo, and add the components shown to make your circuit look like the one 

shown.   

 When soldering, there is no correct or incorrect side to do so on.  If you have access to the 

terminal on the board with the soldering iron, that is an acceptable place to solder.  There is no 

need to solder both sides, but it is okay if you do.  Note that although solder can be applied to 

either side, the components are side specific. 

Note – This is a modified instruction manual in beta testing.  Some of these steps are included 

exclusively to accommodate imperfections included with this beta version.  Check that your circuit 

board serial number is identical to the number indicated on the front page.  If not, obtain a 

different manual. 
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Assembly of the Circuit Board 

Installation of the Board Basics 

 You will need the Following 

components: 

o 2 x 330 Ohm Resistors (o o br) 

o 1 x 10K Ohm Resistor (br bl o) 

o 2 x Red LEDs 

o 2 x Buttons 

o 32 Pin Male Header 

o 7805 IC Voltage Regulator 

o + 9 Volt Battery Terminal 

o – 9 Volt Battery Terminal 

 Cut the 32 Pin Male Header into two 

eight pin segments and two six pin 

segments.  Put the rest aside. 

  

 Install the components as shown.  The 

short lead of the LED is to be installed in 

the hole marked “-“.  Note the side of 

the board the components are installed 

on.  The LEDs and resistors are 

mounted in a different location on 

board 2.4.1

 

 

 

Installation of the Pressure Sensor 

 You will need the following 

components: 

o MPX4250GP Pressure Sensor 

o 6” of 1/8” ID tubing 

 For this installation, we will refer to the 

pin with a small notch cut in the side as 

Pin 1, the flat surface of the sensor as 

the back, and the opposite side as the 

front. 

 The photo shows a sensor with three 

pins removed.  Do not do this. 

 Bend the pins to the back of the sensor 

so they are all in a line at 90 degrees to 

their original position.  Pin 1 should be 

installed in the square hole.

 

 

 

Installation of the Temperature Sensor 

 You will need the following 

components: 

o 3 Pin SIP Machine Socket 

  
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Installation of the Light Sensor 

 You will need the following 

components: 

o 8 Pin DIP Socket 

o 0.1uF (104) Capacitor 

o TAOS TSL230R Light Sensor 

 Orientation matters here.  Pin 1 of the 

Light sensor is indicated by a faint 

indented circle on the front face of the 

chip in the left corner.  Pin 1 on the DIP 

socket is the pin to the left of the notch. 

 Solder the DIP socket, but not the 

Sensor.  This installs with nothing more 

than a press fit.  If the legs of the sensor 

are splayed too far apart, use a table or 

other flat surface to apply even 

pressure and correct the misalignment.

 

 

Installation of the Conductivity Sensor 

 You will need the following 

components: 

o 8 Pin DIP IC Socket 

o 0.1uF (104) Capacitor 

o 0.01uF (103) Capacitor 

o 555 Timer IC 

o 110 Ohm Resistor (Br Br Br) 

o 3 Pin Male Header 

 Both the DIP and the 555 IC indicate the 

location of pin 1 to the left of the notch.  

The 555 IC has a small indented circle 

over pin one on the left side of the chip. 

 

 

Installation of the Data Storage Hardware 

 You will need the following 

components: 

o 3 x 3.3K Ohm Resistors (o o r) 

o 3 x 1.2K Ohm Resistors (Br r r) 

o The Remainder of the 32 Pin 

Male Headers 

o Micro SD Breakout Board 

 The terminal labeled “CD” is not used 

on the Micro SD Breakout Board. 

 Cut a six pin segment off of the Male 

Header, put the remainder aside. 

 This six pin segment will connect 

between the Micro SD board and the 

main board.  

 Circuit Board V2.4 requires that the 

Micro SD board be installed over one of 

the LEDs.
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Connecting the Sensors 

 You will need the following 

components: 

o 2 x 8 Pin Female Headers 

o 15” of 22 Gage Solid Core Wire 

 
 Cut the 15” piece of wire into 8 

segments, then strip off approximately 

3/8” from each end and bend the 

stripped part at 90 degrees as shown 

below. 

 
 The wires need to cross, i.e. Pin 1 

connects to Pin 8, Pin 2 to Pin 7 and so 

on.  

 

 

 

Installation of the Power Switch 

 You will need the following 

components: 

o Remaining Male Headers 

o Jumper  

 Cut 2 pins from the Header

 

  
 For Circuit 2.4.1, the pins and jumper 

are replaced by a slide switch.  

Orientation does not matter, and the 

same holes are used. 
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Section 2 – Housing Assembly 
 

Read these steps carefully.  Failure to do so will result in a leaky sensor, and a likely malfunction.  Take 

your time, and consult your tool safety manuals before proceeding.   

In the following steps, a hand drill and various drill bits will be used.  Make sure that the drill bits are 

sharp, properly installed in the chuck, and you have a secure mounting solution to hold your parts in 

place.  There are curved, slippery surfaces that will be drilled.  This type of surface can lead to a drill 

slipping off course and damaging whatever is in the path of the drill bit.  To counteract this scenario, 

don’t apply much pressure with the drill.  Let the bit do the cutting.  Make an indentation on the plastic 

before drilling to locate the drill bit if the appropriate tools are available.   

When the housing is complete and the epoxy is dry, it is recommended that the water resistance be 

tested.  Install a tube with a binder clip on the hose barb and close the container.  Lower it to a target 

depth, and let it sit for some time.  If the container is dry inside when extracted, this depth will be a safe 

operating depth.
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Fabricate the housing 
 

The final sheet of this manual is a template for 

drilling and installing the sensor probes.  

Remove this page and cut out the template.  If 

the template is the wrong size, print the sheet 

again and select “do not scale” or equivalent 

from the print settings.  Apply the template to 

the housing with tape as indicated on the 

template and drill the four indicated holes. 

 You will need the following 

components: 

o 1/8” Hose Barb 

o 2 x 3” x 1/16” Titanium Rods 

o LM35 Temperature Sensor 

o 3 Contact Green Terminal Block 

 
 Install the terminal block on the 

titanium rods in holes one and three.  

Skip hole two. 

 

 

 

 

 Note the orientation of the 

temperature sensor.  When looking into 

the box from the top, with the probes 

facing away from you, the small tab on 

the sensor faces up and to the right. 

 

 
 Test fit the sensor board to make sure 

all of the sensors and their respective 

connectors will line up.  Tape 

components in place if they will move 

during epoxy filling. 

 Prop the installed housing probe 

assembly up at an angle of 

approximately 75 degrees, an angle 

that allows for the epoxy to cover all of 

the sensors.   

 Tape over the plastic lip of the 

container that will mate with the o-ring 

on the other side of the container to 

prevent epoxy overflow.  It is essential 

that no epoxy get on this seal, as it may 

compromise the depth rating of the 

housing. 

 Thoroughly mix the epoxy, and ensure 

that when the housing is filled, the hose 

barb and at least 1cm of wire from the 

temperature probe is left exposed. 

 Fill the container as shown in the 

picture
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Section 3 – Installing the software 
 

The following steps require a PC (Linux, Apple, or Windows), along with the following free downloads.  

The files are also stored on the memory card if supplied by MIT. 

 Arduino 0017 (http://www.arduino.cc/en/Main/Software, and on MicroSD) 

 FileLogger.V0.6.zip (http://code.google.com/p/arduino-filelogger/, and on MicroSD) 

 Data.log (seaperch.MIT.edu, and on MicroSD) 

 Program.pde (seaperch.mit.edu, and on MicroSD) 

Check the Sea Perch website for version information: 

SeaPerch.MIT.edu 

 

 

Setting up your MicroSD Card 
Install the card in any MicroSD reader.  If provided by MIT Sea Grant, copy all of the files off of the card 

to a new directory on your computer.  Format the card in the Fat16 file system.  You can search Google 

for information regarding this procedure and your computer.   

Once complete, if provided by MIT, copy the file “data.log” to the card and safely eject the card. 

If not provided by MIT, create a file called “data.log” by opening a text editor and selecting the save as 

function.  Write a single “0” (zero) in the file and save.  Check that the file does not have a hidden 

extension such as “.txt” following the “.log.”  If it does, remove it.  Google will provide information on 

this procedure based on your computer type. 

This file is also available from the MIT Sea Perch webpage (seaperch.mit.edu) 

 

 

 

 

 

 

http://www.arduino.cc/en/Main/Software
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Installing the Programming Environment and Libraries 
First install the Arduino programming environment.  When complete, navigate to the folder containing 

libraries (on windows: installation_directory/arduino-0017/hardware/libraries) and copy the unzipped 

“FileLogger” folder into this directory. 

Connect your Arduino microcontroller to the PC via USB out of the housing. 

Launch the program and select the following from the tools menu 

 Tools -> Board -> Arduino Duemilanove 

 Tools -> Serial Port -> your serial port 

If you are unsure of your serial port, guess and check is an appropriate method of determining this 

information. 

Check that the FileLogger library installed correctly by verifying that FileLoggerDemo exists in the 

following location 

 File -> Examples -> FileLogger -> FileLoggerDemo  

If all checks out okay, continue to the next step. 

 

Installing the Software on the Arduino 
Open the Program.pde file with the Arduino program (downloaded from the internet or provided on the 

MicroSD card). 

Verify that all the above steps were performed correctly 

Without the sensor installed, click on 

 File -> Upload to I/O board 

If you receive errors, check the serial port and board selection and try again. 

Once the program compiles, the status box will indicate “Upload Complete.” 
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Section 4 - Testing the Sensors 
Unplug the USB cable and external power from the Arduino and install the sensor board in the housing.  

Insert your formatted MicroSD card with data.log copied onboard, and install the jumper on the power 

pins. 

A red LED will illuminate indicating power is connected; shortly thereafter the other LED will begin to 

blink.  This indicates that the data is being recorded.  After several iterations of blinks, remove the 

power jumper and the MicroSD card.  Open the file created on your computer and check that values 

were recorded.  Conductivity should read zero, as should pressure.  Install a 10 Ohm resistor temporarily 

in the two holes near the conductivity probe and repeat the test.  Optionally you can blow into the tube 

connected to the pressure sensor at the same time.  Check your data again.  You should now see a 

somewhat consistent value for conductivity, and a change in the pressure reading. 
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Section 5 – Calibration 
The thermistor, pressure sensor, and light sensor should be calibrated from the factory.  Nothing needs 

to be done with these probes. 

 

Conductivity Calibration 
Install the 10 Ohm resistor in the two holes nearest the conductivity probe.  Hold the B1 button during 

startup.  Release when both LEDs blink in unison.  The sensor is now calibrated.  Press the reset button 

to begin taking data. 
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